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LaserPAD™

General
Description

The LaserPAD Power Analysis Display software combined with the
Coherent SmartSensor Interface Module, is a rugged, compact, power
analyzer that interfaces with the full line of Coherent “smart” detector
heads. LaserPAD provides a unique combination of a high speed graphi-
cal bar for laser tuning, a precise digital display, and graphics analysis of
power and alignment on a high resolution color display.

The LaserPAD can be used with all lasers commonly manufactured today
– from the UV to the IR, with rated power from nanowatts to kilowatts –
simply by plugging the appropriate detector head into the SmartSensor
Interface Module.

The SmartSensor Interface Module (SSIM) is a unique detector interface.
This module will interface with any Coherent Thermal or Semiconduc-
tor SmartSensor. The SSIM contains the input amplifiers and the digital
converters necessary to accurately analyze CW laser power. When this
circuitry is combined with the capability to utilize Coherent SmartSensor
technology, you now have a stand alone black box power meter. The serial
communication port will transmit the corrected CW laser power and beam
position for display and analysis with the LaserPAD software. The serial
and USB interface is perfectly suited to communicate with any compat-
ible host computer or OEM application. The SmartSensor Interface Mod-
ule software can also be updated with the USB port. Please contact Co-
herent for any OEM application utilizing the SmartSensor Interfaced
Module.
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Features of the LaserPAD are described below.

CW Power Measurement
The LaserPAD supports CW power measurement. (See Appendix A for a
list of heads supported.)

Semiconductor and Thermal Detectors – LaserPAD is compatible with
Semiconductor Sensors and the full range of Coherent’s patented thermal
SmartSensor Heads, providing power measurement capability to 5 KW.

Versatility
More than just a power meter, the LaserPAD also provides complete power
trend information, beam position drift measurement, statistics and tuning.

Data Files
The LaserPAD can generate results files for all trending and position sta-
bility data. The statistics and data points are saved in a comma delimited
format for easy spreadsheet analysis.

Detector Head Hot Swapping
The LaserPAD allows swapping of detector heads while power remains
On. After a swap, the SmartSensor Interface Module will reset with the
correct settings for the new detector head.

SmartSensor™ Technology
LaserPAD detector heads utilize Coherent’s SmartSensor™ Technology.
Each SmartSensor has an EEPROM that stores the characteristics and
calibration data for the detector. The detector information is read by the
SmartSensor Interface Module at start-up. This will eliminate the need to
make manual changes associated with unique detector settings.

➠ NOTE: The LaserPAD Software will store user-required entries for
Display Average and Wavelength.

Features
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Tuning Sensitivity and Feedback
The tune bar and digital needle movement in the LaserPAD gives a
fast, smooth feedback and provides the response time necessary for laser
tuning.

Digital Precision
The LaserPAD software provides precise digital readout of power as well
as indicators for warning or error conditions and graphic analysis of data
collection.

Beam Alignment
Thermal disk CW sensors provide a quadrant display of beam position
on the detector head. Centering the beam on the detector head achieves
maximum accuracy.

Broad Wavelength Range
Coherent SmartSensors cover the spectrum from 0.19 to 10.6 µmeters.

Ease of Use
LaserPAD controls and the simplified menu structure provide ease of use
with minimal training. All adjustments for different detector heads are
handled automatically using Coherent’s SmartSensor Technology.

Portability
The compact, lightweight SmartSensor Interface Module and internal
rechargeable battery pack create a system that is easily transported from
lab to lab or around the world.

Reliability
The SmartSensor Interface Module is designed to withstand the rigors of
travel and regular field use. Coherent’s rugged detector head design has
been the industry standard for more than 30 years.

Features



4

LaserPAD™

Accuracy
The combination of SmartSensor Technology, laser wavelength entry, and
accurate beam positioning information create a highly accurate laser mea-
surement system.

Features
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The LaserPAD SmartSensor Interface Module and detector heads are
shipped in foam inserts. Batteries are installed in the SmartSensor Inter-
face Module prior to shipment. To insure correct battery operation, the
batteries require an initial over night charge (approximately 14 hours).

Visually check all cartons for damage before unpacking. If there is no
visible damage, remove all items from the cartons and inspect for damage.
Advise Coherent of any damage immediately. A Returned Material Au-
thorization will be issued for any damaged instruments (see the last page
of this manual for service information).

Unpacking
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Software
Installation

Description
The LaserPAD software installation CD contains the following items:
LaserPAD software installation files, LaserPAD User Manual .pdf file,
User Readme file and SSIM software update program. The LaserPAD
software installation will work in conjunction with Microsoft® ActiveSync™

software to load LaserPAD on your Pocket PC. The LaserPAD software
installation will load the required files into the default (C:\Program
Files\LaserPAD) or user specified location on the host PC. When Active
Sync‘ is running, the installation will load LaserPAD on your Pocket PC.
The SSIM update software will be located in the default or user specified
location after the software installation process is complete.

Setup Requirements
The Pocket PC software installation requires a host computer with
ActiveSync™ software installed. The LaserPAD software can be installed
with a serial or USB communication cradle. Please review the require-
ments associated with ActiveSync for further information.

Installation Procedure
1. Start the host computer with the communication cradle connected.

2. Place the Pocket PC in the communication cradle. Verify that
ActiveSync is linked and communicating to the Pocket PC.

3. From the start menu select Run. Type (name of CD drive):
\setup.exe (for example E:\setup.exe) and press Enter.
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4. The default path for the installation on the host PC will be dis-
played. You may now change the installation path on your host
computer if the default path is not desired.

Software
Installation

6. The setup is now loading the application on the Pocket PC.

 5. You will now be prompted to install the software in the path se-
lected in the previous step. Click Yes to continue.
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7. When the loading process is complete, you will be prompted to
check the Pocket PC screen for any messages.

8. Tap the Yes to All buttons on the Pocket PC to update the com-
ponents required for the LaserPAD application. The installation
is complete. A Word document named LaserPAD User Manual
will also be loaded on the Pocket PC.

➠ NOTE: If the LaserPAD user manual MS Word document is deleted,
you can drag a copy from the installation CD to the ActiveSync folder
and it will be loaded on the Pocket PC.

Software
Installation
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Input PanelControls &
Connections

Detector Input – Connection to the Coherent SmartSensor Head using
a DB-25 connector.

5 VDC RS-232 USB
OFF

ON

SmartSensor™ Interface Module

I

0

Output Panel

Detector

5 VDC Power Input – Connect the provided 5V Power supply. The power
supply is designed for the following AC input requirements: 100-240V,
~0.2A, 50-60 Hz. The 5V input also provides battery charging capability
for the SmartSensor Interface Module. When the 5V supply is connected
to the Interface Module, the battery will be charging regardless of the
power switch position. The USB connection does not provide battery
charging capability.

➠ NOTE: A fully charged battery will typically operate the SmartSensor
Interface Module for 12 hours continuously. Do not exceed this 12
hour cycle without recharging. A low battery condition requires an over-
night charging cycle (approximately 14 hours).

RS-232 Input/Output – Connect the Pocket PC serial interface cable to
this DB-9 connector.
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USB Input/Output – Connection for SmartSensor Interface Module to
PC based applications.

Power Off/On – Switches input power on and off to the SmartSensor
Interface Module. Utilize this switch to reboot the SmartSensor Interface
Module if necessary.

Power Indicator LED – The LED will be illuminated when the 5V power
is active and the power switch is in the ON position.

Controls &
Connections
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Description
The SmartSensor Interface Module (SSIM) contains the software required
to interface with Coherent SmartSensors. The SSIM software will man-
age the internal circuitry, SmartSensor calibration information, calcula-
tions and data transmission. If any function is changed or a feature is
added, the SSIM software can be upgraded by the user. The update soft-
ware is installed during LaserPAD software installation.

System Requirements
The host computer requires an active USB port for the SSIM software up-
date. The software update can be accomplished with the following Win-
dows® operating systems: Windows 98, Windows 2000 and Windows ME.

Software Information
The SSIM software update requires the software update file (ssimx.hex).
The x in the file name corresponds to the current revision of the file. The
ssim.hex file can be obtained from a floppy disk, E-Mail or the Coherent
Product Web Site. The location of the update software is specified during
the LaserPAD software installation. The default location is C:\Program
Files\LaserPAD.

SSIM Software Update Procedure
1. With the host PC running, connect a USB cable between the

SmartSensor Interface Module (SSIM) and the host PC.

2. Move the SSIM power switch to the ON position. The host PC
will detect the SSIM as new hardware. If the proper USB drivers
do not reside on the host PC, you may be prompted to load them.
The USB drivers are located on the LaserPAD installation CD.
Place the LaserPAD installation CD in the host computer CD
drive. Type the CD drive letter in the Windows dialog box, which
is asking for the location of the USB driver files, and click OK.

SmartSensor
Interface
Module
Software
Update
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3. To start the SSIM update software, select “Run” from the Win-
dows Start Menu. Type C:\Program Files\LaserPAD\SSIM
Update.exe and then click OK. If the LaserPAD software was not
installed in the default location, alter the C:\Program
Files\LaserPAD appropriate to the user specified location.

SmartSensor
Interface
Module
Software
Update

4. The following screen should appear. Click on the large Down-
load Application button on the screen.
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5. When the Download Application button is clicked, a standard
Windows Open dialog box will appear. Use this box to specify
the location of the ssim.hex file. The example shown below would
correspond to a floppy disk update.

6. When the Open button is clicked, the file will be loaded in the
SmartSensor Interface Module. This process will take approxi-
mately 30 seconds for the update to complete.

➠ NOTE: Do not turn off power to the SmartSensor Interface Module
during the software update process.

SmartSensor
Interface
Module
Software
Update
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➠ NOTE: To ensure optimum performance of the LaserPAD software,
check the list of programs currently running and verify that LaserPAD
is the ONLY program that is currently running. Many Pocket PC pro-
grams consume the memory necessary to operate the LaserPAD software
at optimum levels.

➠ CAUTION: You should exit the LaserPAD software when it is not in
use. The LaserPAD software utilizes the serial communication port to
obtain data from the SmartSensor Interface Module. If you attempt to
synchronize your Pocket PC with a host computer and the LaserPAD
software running, you will experience a conflict between the LaserPAD
software and the synchronization software on the host PC. Check the
current list of running programs and verify that the LaserPAD software
is NOT running. If the LaserPAD software is not running the Pocket
PC should now synchronize with a host computer.

➠ CAUTION: Many Pocket PC programs consume memory through nor-
mal use. This situation can occur by starting and exiting programs. If
the performance of the LaserPAD software does not appear to update at
optimum rates, press the mechanical system reset button on the Pocket
PC. This button is normally located on the back or bottom edge of the
Pocket PC. This reset button does not effect installed programs or data,
it will clear memory and allow software to run at optimum levels.

Start Up Procedure
1. Connect the 5 volt power to the SmartSensor Interface Module. If

the SmartSensor Interface Module battery is in a charged condition,
it is not necessary to connect the 5 volt supply.

2. Connect the desired Coherent SmartSensor Head to the SmartSen-
sor Interface Module.

3. Connect the RS-232 cable between the SmartSensor Interface Mod-
ule and the Pocket PC.

4. Move the SmartSensor Interface Power Switch to the ON position.

5. Power up the Pocket PC.

Start Up
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6. Select Programs from the Pocket PC Main Menu.Start Up

7. Tap on the LaserPAD Icon in the program list.

8. The LaserPAD splash screen should now appear.

LaserPAD
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9. A connection status box will appear on the screen. The LaserPAD
software will first connect with the SmartSensor Interface Mod-
ule. When the module is found, the SmartSensor parameters will
be loaded, followed by all of the user settings.

10. When the status box has cleared from the screen, you are ready to
begin using the Laser Power Analysis Display and SSIM.

➠ CAUTION: Insure that the detector head is rated for the power
density of the laser. Power density greater than the rating of the sensor
will damage the detector head.

Start Up
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Operation and use of the LaserPAD is through the various display and
analysis screens and the ability they provide to setup and control the sys-
tem. There are four primary screens. The Setup screen provides basic,
system wide control functions.

The information displayed on the Home screen is detector head depen-
dent. The other two analysis screens – Tune and Trend - provide controls
that are consistent with all detector heads.

➠ NOTE: Please review the table of contents for information appropriate
to the detector utilized. Separate sections will be provided for Thermal
Quadrant Detectors and Semiconductor Sensors.

Screens
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Coherent Thermal Quadrant SmartSensors measure the flow of energy
through an array of thermoelectric cells. These detectors are utilized for
measuring medium to high power CW lasers. These sensors have an in-
trinsically flat spectral absorption from the UV to the far IR. The small
variations in absorption over this wavelength range are calibrated into the
SmartSensor EEPROM. The patented Coherent thermal quadrant detec-
tors provide the capability to measure position and power simultaneously.
Please review the list of supported detectors in Appendix A.

Thermal Quadrant Over Temperature - If the temperature of a thermal
sensor exceeds the maximum operating temperature at any time, the screen
will go blank and then the OVER TEMPERATURE message will appear
in the middle of the screen. When the temperature is within limits, nor-
mal operation resumes.

Thermal
Quadrant
Sensor
Operation
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Thermal
Quadrant Sensor:

Settings Screen

The Settings Screen provides access to Global Controls and Settings. The
four Radio Buttons at the top of the Setting Screen provide access to
groups of similar controls and settings. The Settings Screen can be ac-
cessed with the Home Screen Options Menu. The Options Menu will
only appear when the Home Screen is active. When the Setting Screen is
active click the OK button in the top right hand corner to return to the
Home Screen.

➠ NOTE: You can also access the Settings Screen by tapping the current
Wavelength value on the Home Screen.

The Settings Radio Button will be active when you enter the Settings
Screen. This screen contains global controls that are commonly used.

Wavelength - The wavelength setting is essential to ensure the accuracy
provided by Coherent Smart Head Technology. The Thermal Detector
Heads contain information to correct for variations in absorber response
associated with wavelength. Tapping on the current Wavelength value dis-
played on the Settings Screen will allow you enter a new value. Each time
the LaserPAD software is started, the previous wavelength is restored.

Thermal Quadrant Sensor: Settings Screen
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Attenuation – Enter the amount of optical attenuation due to beam split-
ters, attenuators, or other optical elements. All displayed data is automati-
cally multiplied by the current attenuation value.

➠ NOTE: All Trend and Tune data is multiplied by the current attenua-
tion value.

Tap the current attenuation value to enter a new attenuation value. You
can enter any value between 0.01 and 9999.99.

Thermal
Quadrant Sensor:

Settings Screen

Average – Enter the number of readings to be averaged for the displayed
power value. Valid entries range from 1 to 200. Measurements are calcu-
lated at 10 Hz (i.e., 10 per second). The display is updated at 3 Hz with
the value of the most recent average. The Display Average is the number
of 10 Hz measurements to be used in the average using the running aver-
age method. The display itself is still updated at 3 Hz.
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➠ NOTE: Display averaging affects the Trend and Tune functions.

The current display average is restored each time the software is started.

Thermal
Quadrant Sensor:

Settings Screen

Display Colors – The LaserPAD software provides the capability to change
the colors on data displays, panels, background, plot lines, cursors and
histogram bars. The display color changes are made to accommodate user
preferences or allow data to be viewed with laser safety eyewear. To change
a color, tap on the parameter to be changed and select a color from the
pallet that appears. The current color settings are restored each time the
LaserPAD software starts. The default button on the Settings Screen al-
lows you to restore all of the colors to the standard factory settings.

➠ WARNING: Do not match data colors with background colors. If
data appears to be missing from the display, tap the default button on
the settings screen.
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Head Data – When the Head Data radio button is selected, the following
data associated with the current SmartSensor will be displayed: Head Name,
Serial Number, Manufacture Date, Calibration Date and Calibration Due
Date.

➠ NOTE: Please note the Calibration Due Date to ensure the continued
accuracy of your Coherent SmartSensor.

Thermal
Quadrant Sensor:

Settings Screen

Alarms – Coherent SmartSensor Technology maintains accuracy within a
specified range of temperature, alignment and input power. This range is
stored in each detector and monitored by the LaserPAD software. The
alarm screen will allow you to activate and deactivate additional prompts
when the factory specified ranges have been exceeded. The visual align-
ment/over range and audible/visual temperature alarms are set to an on
condition by the software. Audible Alignment and Over Range settings
are accessible to the user. Tap the desired box to set the on or off condi-
tion. Each time the software is started, the previous settings are restored.

➠ NOTE: Tap the Rng label in the Home Screen Settings Panel for quick
access to the Alarm Settings.
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User Alarms – The user alarms are custom alarms associated with Power
and Alignment. To activate a custom user specified alarm, tap on the au-
dible or visual check box associated with the desired parameter. When a
check box is active you can specify the value of the parameter to trigger
the user specified alarm. Tap on the current value to enter a new value.
The range of values is dependent on the current SmartSensor connected.
Each time the software is started, the previous settings are restored.

➠ NOTE: Be sure to specify the proper units for the Power Alarm
Settings.

Thermal
Quadrant Sensor:

Settings Screen
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The Home Screen associated with a Quadrant CW SmartSensor Head is
different than the Home Screen associated with a Semiconductor Smart-
Sensor. The Settings Panel displays either the default parameters or the
current operating parameters for: Display Average, Wavelength, Attenua-
tion and Offset.

➠ NOTE: Tap the current Wavelength Value for quick access the settings
screen.

The Home Screen displays current Power and Alignment at a rate of 3
Hz. The Trend, Alignment and Position Stability screens collect and ana-
lyze data at a rate of 10 Hz.

➠ NOTE: Check current Wavelength and Attenuation values to ensure valid
results. Review the Settings Screen section for further information.

Target – showing the location of the beam on the detector is on the left
side of the display. For maximum accuracy, align the detector so that the
beam location indicator is within the small inner circle on the target.
When the beam location indicator appears outside of the inner circle, an
Out of Alignment message will appear. The message will disappear when
the proper alignment condition is restored.

Thermal
Quadrant Sensor:

Home Screen

Thermal Quadrant Sensor: Home Screen
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Thermal
Quadrant Sensor:

Home Screen

Proper Alignment Out of Alignment

➠ NOTE: Tap the target to jump to the Alignment Screen.

Settings Panel – The Settings Panel will display the values selected from
the Settings Screen. Active alarm labels will display below the Settings
Panel. Alarm labels will appear below the Settings Panel. These labels will
appear green when current values are within the specified limits and red
when the specified limits have been exceeded.

Status Panel – The Status Panel is located in the lower left corner of the
Home Screen. This panel displays the current Coherent SmartSensor con-
nected to the SmartSensor Interface Module. The Status Panel also con-
firms communication between the Pocket PC and the SmartSensor Inter-
face Module.

Properties Panel

Offset – Tap the OFFSET button to use the current power reading as
an offset value (zero reference) to eliminate a constant background
reading. When the offset box is first tapped, the screen displays zero
and the offset value is shown in the Settings Panel. The second time
the box is tapped, the offset is deactivated and the offset value is re-
turned to zero regardless of the power input at the time the box is
tapped. The screen reflects a 0 offset (offset = none).
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Thermal
Quadrant Sensor:

Home Screen

Tune Bar – Tap on the Tune Bar button to display a digital tune bar
on the Home Screen. When the tune bar is active a Reset button will
also appear in the Properties Panel. The Tune bar will display current
relative scale indicators at each end. When the Tune Bar is active,
each new maximum value is displayed as the Peak value above the
Tune Bar. A vertical indicator remains at the current peak location on
the Tune Bar. The Reset button will reset the Peak value and the cor-
responding Peak indicator bar. Each new peak value collected will
generate an audio beep, move the indicator bar and display a new
peak value.

➠ NOTE: To remove the Tune Bar from the Home Screen, tap the Tune
Bar button a second time.

➠ NOTE: The Tune Ana button is not active when the Tune Bar button
is activated.

File Menu – The File Menu provides the capability to Exit the LaserPAD
software and view the current software version. To exit the LaserPAD
software, tap the File Menu on the Home Screen. When the menu ap-
pears, tap Exit. You can also exit the LaserPAD software by switching the
SmartSensor Interface Module to the off position. The connection dialog
will appear. Tap the Exit button in the connection dialog to exit the Laser-
PAD software. The about item in the File Menu will display the current
LaserPAD software and firmware version. To display the current version,
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tap file on the LaserPAD Home Screen and then tap About. The current
LaserPAD software and firmware version will display on the screen. Tap
OK in the About dialog and return to the Home Screen.

Thermal
Quadrant Sensor:

Home Screen

Options Menu – The Options menu will provide navigation to the other
(Settings, Trend, Alignment, Position Stability) screens in the LaserPAD
software. Please review the detail associated with each screen for further
information.

View Menu – The View Menu will provide access to the Tune Bar, Tune
Needle and Large Display. Review the detail associated with each item
listed in this menu.

Large Display – The LaserPAD software will allow you to display the
Home Screen Power in a Large Font. Toggle between Normal Power Font
and Large Power Font by tapping the Magnifying Glass Icon on the Pocket
PC Command Bar.

➠ NOTE: Tap the Current Power value to toggle between large font and
normal font.

Display Units – The LaserPAD Software provides the ability to display
in units of Watts, dBm and dB. To select the desired display type, tap on
the appropriate units shown on the Pocket PC Command Bar at the bot-
tom of the screen. The Watts will display from mW to W to KW as nec-
essary. The dBm value is calculated utilizing the following formula:
dBm = 10 log [current reading (mW)]. When dB is selected, the current
reading will be established as a reference value. All subsequent readings
will be measured and displayed relative to the reference value established.
To establish a new reference for dB, tap the dB REF button in the
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Properties Panel. The dB display utilizes the following calculation:
dB = 10 log (current power reading/reference power reading).

➠ NOTE: Tap the current display units to cycle through the three display
units available (W, dBm, dB).

Thermal
Quadrant Sensor:

Home Screen



29

LaserPAD™

Thermal
Quadrant Sensor:

Tune Screen

Tune Screen

Tune Needle – The Tune Ana button will display a separate tune screen
with the appearance of an Analog Needle. This screen operates in the
same manner as the Tune Bar. The current value is displayed in large font
at the top of the screen. The Peak value is displayed in a smaller font
below the current value. The current scale values are located at each end
of the scale radius. A maximum indicator bar remains on the scale at the
location indicated by the Peak Value. The reset button will reset the Peak
value and the corresponding indicator bar. Each new peak value collected
will generate an audio beep, move the indicator bar and display a new
peak value. Tap the OK button in the top right hand corner of the screen
and return to the Home Screen.
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Thermal
Quadrant Sensor:

Trend Screen

➠ NOTE: The trend data is collected by the SmartSensor Interface Mod-
ule at a maximum rate of 10 Hz. The LaserPAD software may not plot
the data at the 10 Hz rate. The plotted data represents the 10 Hz
collection rate.

Trend Screen

Trend Screen – The Trend Plot is a display of Power vs Time. The dis-
played data is a result of the selected vertical scale, number of points and
duration of the plot. The duration and the number of points are set be-
fore trend data is collected. When a trend run is started, the Stop button
will replace the Start button. If a trend run is stopped before the duration
is complete, data analysis will be available. When the trend run is stopped
or completed, a measurement cursor will appear and provide the capabil-
ity to analyze individual points. When a trend run is stopped or com-
pleted, the data analysis buttons will come into focus. These buttons in-
clude Statistics, Histogram and data saving capability. The Trend Plot will
also display the Live Power and the data collection interval based on the
current trend duration.

➠ NOTE: The trend data will utilize current Offset, Attenuation and
Average settings.

➠ NOTE: Tap the current Average Value to enter a new average value.
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Thermal
Quadrant Sensor:

Trend Screen

Scale – The vertical scale can be set before and after a trend run. The
manual scale can be set to any value desired. If data is collected beyond
the range of the manual scale settings, those points will be plotted along
the top or bottom of the scale appropriately. When the vertical scale is
changed after a trend run, the OK button in the value change dialog will
plot the data with the new scale value. See Trend Options for additional
Range features.

Auto Scale - If the Auto Scale box is checked, the LaserPAD software will
manage the vertical scale appropriate to the range of data collected. The
Auto Scale can be removed after data collection for a desired manually
scaled display. When the display is toggled between Auto Scale and Manual
Scale, any available data will be plotted appropriate to the new setting.

Duration – The Duration box will allow you to set the duration of the
trend run before collecting data. A trend run can range in duration from
0.5 minutes to 99 hours (5490 Minutes). The duration is entered in min-
utes. Entered values will be rounded to the nearest 0.5 minutes.

Number of Points – The number of points selected determines the inter-
val between each point collected. The trend data is collected at a rate of 10
Hz. This data collection rate determines the maximum number of points
available for a given duration. For example you can select a maximum of
300 points for a 30 second trend run. The LaserPAD software will also
limit the maximum number of points collected to 2000.

Units – The vertical scale units can be selected appropriate to the data
collected. When utilizing manual scale verify the appropriate units are
selected. Trend data can be plotted as dBm. If dBm is selected from the
Home Screen, the Trend Screen will default to dBm.
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Statistics Panel/Measurement Cursor – The Statistics Panel contains cur-
rent statistical trend information. The measurement cursor information
is also displayed in this panel. The vertical bar displayed in the trend plot
corresponds to the current measurement cursor data. The measurement
cursor is active when static results are displayed. When a trend run is in
progress, the measurement cursor is not available. When the trend dura-
tion is complete or the Stop button is tapped, the measurement cursor
can be utilized on the displayed data. A scroll bar will appear below the
trend plot when the measurement cursor is active. The measurement cur-
sor results will appear in the Statistics Panel. The measurement cursor is
controlled by dragging the center section of the scroll bar or by tapping
the arrows at either end of the scroll bar. The cursor results appear as the
top three values displayed in the Statistics Panel. The top value in the
Statistics Panel corresponds to the current cursor location, relative to the
number of points collected. The second value displayed corresponds to
the Power value associated with the current cursor location. The third
value in the Statistics Panel corresponds time associated with the displayed
cursor power value. The remaining three values (Min, Mean and Max)
correspond to statistics generated by the current trend points collected.

Thermal
Quadrant Sensor:

Trend Screen
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Trend Control Buttons
Start - The Start Button will clear current data and begin a new trend run
utilizing the current setup parameters. When the trend run begins, the
Start button will change to a Stop button. The Stop button will stop the
trend run and generate statistics based on the data currently collected. All
functions associated with a complete trend run will be available if the run
is stopped before completion.

Clear – The Clear button will clear all data, statistics and histograms asso-
ciated with data that is currently available. The Clear button will clear
data only and does not effect the current settings.

Statistics – Tap the Stats Button to bring up a separate screen displaying
all statistics associated with the current data. The Stats button is not avail-
able when a trend run is in progress or current data has been cleared. The
statistics will display the minimum and maximum point collected and
the mean average of all points collected. The delta value is the difference
between the minimum and maximum point and can be displayed with
higher precision than the minimum and maximum points. The Sigma
value is the standard deviation of all points collected. The standard devia-
tion is calculated in the following manner, where X is the array of points
and N is the number of points.
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The Points Taken, Duration and Interval shown on the Statistics screen
are a result of the setup parameters established before the data was col-
lected. The Save button will operate in the same fashion as the Save but-
ton on the Trend Screen. Review the section on saving data for further
detail. The OK button on the Statistics Screen will return to the Trend
Screen.

Histogram – Tap the Histo Button on the Trend Screen to display a sepa-
rate screen containing a Power Trend Histogram and the associated data.
The Power Trend Histogram is constructed by dividing the trend delta
value by 20. This result will determine the bar division on the histogram.
The vertical scale is constructed by taking the bar with the maximum
number of points and adding 5 to set the vertical scale. The Maximum,
Minimum, Mean, Calculated Bar Division and the Number of Points
collected will also be displayed on the Histogram Screen. The OK button
will return the display to the Trend Screen.

Thermal
Quadrant Sensor:

Trend Screen
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Trend Screen

Save Trend Data – Tap the Save button on the Trend Screen to save the
current data. The Save button will generate a comma delimited text file.
This format will allow you to view the trend data with Windows Notepad
or analyze the data with Microsoft Excel. The Pocket PC will display the
data with Pocket Word. To view the data with Pocket Excel, the Trend
Text File will have to be exported to a host computer. Open the file with
Microsoft Excel and save the data as an Excel Workbook.
Export the data in workbook form to the Pocket PC. The data will now
be available for analysis utilizing Pocket Excel. Each Trend Data File con-
tains the appropriate setup information, statistics and a complete array
containing each data point collected.
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Trend Screen
Trend Information
7/23/2001 9:55

Test 1

10600 nM
Average 1
Attenuation 1
Max 4.20 mW
Mean 389 mW
Min 3.42 mW
Delta mW
Sigma mW
Points 103
Duration 0 mSec
Interval 200 mSec

Points Displayed in Watts
Point Data Time

1 0.392 100 mSec
2 0.398 301 mSec
3 0.402 503 mSec
4 0.405 704 mSec
5 0.403 905 mSec
6 0.401 1.1 Sec
7 0.4 1.3 Sec
8 0.398 1.5 Sec
9 0.396 1.7 Sec
10 0.393 1.9 Sec
11 0.395 2.1 Sec
12 0.398 2.3 Sec
13 0.399 2.5 Sec
14 0.4 2.7 Sec

Example Trend Data File

➠ NOTE: To display data properly with Microsoft® Excel™, select
tab, space and comma deliminated on the second page of the Excel
Import Wizard.
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Trend Options Button – Tap the Opt button on the Trend Screen to
access a variety of Trend Options.

Trend Options – The Trend Average Reading function will utilize the
Display Average Process to collect the trend data. When the Trend Aver-
age box is checked the data collection will utilize the current average value
set. Activating this box will provide the opportunity to change the current
Average value. The Trend Below Zero function will collect data with a
negative value. The Auto Start function will allow the user to specify a
threshold power to start a trend run. When this function is active you can
specify the threshold power. When the threshold power or greater is col-
lected, the trend run would begin. The data collection will not stop if the
power falls below the specified threshold.

Thermal
Quadrant Sensor:

Trend Screen
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Alignment Screen – The Align screen displays the position of the beam
on the detector and allows use of quadrant thermal detector heads for
optical system alignment. The displayed target at 1X resolution repre-
sents the clear aperture of the detector with aperture size shown in mm
just below the target. Tap the Pos button to bring up the Position Stability
Screen. Tap the OK button in the upper right corner of the Alignment
Screen to return to the Home Screen.

Zoom – Tap the IN or OUT Zoom Button to increment the resolution
on the display target. The OUT button reduces the current target resolu-
tion by a factor of two with each button tap. The IN button increases the
current target resolution by a factor of two with each button tap. The
current resolution will change the size of the displayed target aperture.
The current size of the display aperture is shown along with the current X
and Y position values in the lower data panel.

Absolute and Relative Modes - Tap the REL / ABS button to toggle the
representation between Absolute and Relative modes. The condition of
the button will display the mode that is NOT currently active. When the
Alignment Screen is operating in Absolute mode, the display will reflect
the actual position of the beam on the detector. When the Alignment
Screen is operating in Relative mode, the display will reflect the position
of the beam relative to the position stored when the REL button is tapped.
When the REL button is tapped the target will display as centered and the

Thermal
Quadrant Sensor:

Alignment
Screen

Alignment Screen
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displacement values will indicate zero. The subsequent changes in beam
position will be displayed as a displacement relative to the target center
instead of the actual position on the detector sensor. The current mode,
Rel or Abs, appears on the border of the data panel and adjacent to the
target. The default mode is Absolute.

Alignment Calibration – The LaserPAD software contains a routine to
increase the Alignment Screen accuracy. The factory settings reflect de-
fault levels of accuracy. The Alignment Screen accuracy can be improved
with the use of a micrometer translation stage. Begin the calibration pro-
cess by mounting the Coherent SmartSensor on a micrometer translation
stage. Center the beam on the sensor by utilizing the 4x resolution on the
Alignment Screen.

1. Tap the Cal button on the Alignment Screen.

2. Verify that the beam is centered on the SmartSensor.

Thermal
Quadrant Sensor:

Alignment
Screen
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Alignment
Screen

3. Translate the SmartSensor exactly 5.00 mm by using the transla-
tion stage. Tap the next button.

4. Tap the Finish button to store the new alignment calibration val-
ues. The values on the Alignment and Position Stability screen
will now be displayed relative to the 5.00 mm displacement cali-
bration. These values will be updated each time the calibration
routine is executed.
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Position Stability Screen – The Position Stability Screen will plot posi-
tion data as a function of time. The upper portion of the screen will dis-
play the data in strip chart form. A polar representation of the position
stability data will be displayed below the strip chart. The Position Stabil-
ity Screen also contains various controls to collect and display data.

➠ NOTE: The Alignment Screen Mode (Absolute or Relative) controls
the operation of the Position Stability Screen.

Strip Chart Display – The top of the Position Stability Screen will dis-
play the collected data in strip chart form. The X and Y data will be dis-
played on the same Strip Chart. The color of the X and Y plot can be
selected utilizing the Settings Screen. To change the X and Y color, tap the
OK button and return to the Home Screen. Tap the Options Menu and
then tap settings. Tap the Set display colors button to enter the color
settings screen. The X and Y plot colors can be changed in this screen.
The Strip chart scale is set with the zoom buttons on the Position Stability
Screen. Tap the In button to increase the resolution on the strip chart. Tap
the Out button to decrease the resolution on the strip chart. If data is
plotted as a straight line at the top or bottom of the strip chart, tap the
Out button to decrease the screen resolution.

Thermal
Quadrant Sensor:

Position Stability
Screen

Thermal Quadrant Sensor: Position Stability Screen
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Polar Plot – The Polar Plot will display the position stability data in polar
form. Before the Position Stability Run begins, the Polar Plot will display
in the same form as the Alignment Screen. The dot will indicate the beam
position and the current polar plot resolution will display on the strip
chart. When the Position Stability Run begins, the Polar Plot will display
the displacement variation accumulated as the run progresses. Each point
on the Polar Plot will display as a position. Multiple X and Y location
points of equal value, will display as a single point. When the Position
Stability Run is complete, the Polar Plot will display the complete range
of displacement over the run duration.

Thermal
Quadrant Sensor:

Position Stability
Screen

Properties Panel

Start - The Start button will start a Position Stability run and clear
the data currently displayed. When the Start button is tapped, the
Position Stability Run will begin and the button will now read Stop.

Clear - The Clear button will clear the data currently displayed with-
out starting the Position Stability Run. The Clear button can be uti-
lized to clear the data and display the Alignment Dot on the Polar
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Plot. This condition will allow you to adjust the detector position
before starting another Position Stability Run.

Duration – The duration setting will dictate the length of time for
the Position Stability Run. The duration can be set in .5 minute in-
crements between 0.5 minutes and 99 Hours (5940 Minutes). The
Position Stability Run will collect points at 10 Hz to a maximum of
2000 points. When a duration is set to be greater than 200 minutes
the interval will be adjusted to maintain the 2000 point maximum.

Save – The Save button will allow you to save the points collected in
the Position Stability Run. When the Save button is tapped, you will
be prompted to save a single line of header information if desired.
The header information will be attached to the top of the file. The
data file contains the interval and duration information and each pair
of X and Y data points collected. The file will be in delimited text
format for spreadsheet analysis.

Example Position Stability Run Data File

Position Data Points
7/19/01 6:42
Test 1

Points Taken: 300
Duration: 1.0 Min
Interval: 200 ms
Points displayed in mm

 X  Y
5.68 2.27
5.68 2.27
5.87 2.46
6.06 2.65
5.87 2.46
5.87 2.27
6.06 2.27
6.06 2.46
5.87 2.46
5.87 2.65
6.06 2.65
6.06 2.84
5.87 3.03
5.68 3.03
5.49 3.22
5.68 3.03
5.68 3.03
5.87 3.03
5.87 3.22
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➠ NOTE: To display data properly with Microsoft® Excel™, select
tab, space and comma deliminated on the second page of the Excel
Import Wizard.

Align - The Align button can be utilized to jump to the Alignment
Screen. The Alignment Screen contains a Trend button for return to
the Position Stability Screen.

Zoom In and Zoom Out - The Zoom In and Zoom Out buttons are
utilized to set the display scale. When the zoom buttons are utilized
before a Position Stability Run, the Alignment Dot can be utilized to
adjust the detector position. When a run has been stopped or com-
pleted, the Zoom buttons can be utilized to adjust the display of cur-
rent data. When the current zoom level is changed, a Replot button
will appear. The Replot button will allow you to set the desired zoom
level without waiting for the data to Replot each time the zoom level
is changed.

Thermal
Quadrant Sensor:

Position Stability
Screen
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Coherent Semiconductor sensors are highly sensitive detectors for the spec-
tral regions from 250 nm to 1065 nm (Silicon) and 800 nm to 1800 nm
(Germanium). The response of a Semiconductor Sensor will vary greatly
with wavelength and a precise knowledge of the laser source wavelength is
critical for accurate measurements. The semiconductor material can satu-
rate with small input beam diameters above 10 mW. Please review Ap-
pendix A and B to confirm the safe operating region. Semiconductor Sen-
sors can also utilize a calibrated attenuator. Please call Coherent for addi-
tional attenuation information. Coherent Semiconductor Sensors do not
provide position sensing information. The appearance of the Home Screen
and Options Menu will be different than the Quadrant Thermal Sensors.

Semiconductor
Sensor
Operation
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The Settings Screen provides access to Global Controls and Settings. The
three Radio Buttons at the top of the Setting Screen provide access to
groups of similar controls and settings. The Settings Screen can be ac-
cessed with the Home Screen Options Menu. The Options Menu will
only appear when the Home Screen is active. When the Setting Screen is
active click the OK button in the top right hand corner to return to the
Home Screen.

➠ NOTE: You can also access the Settings Screen by tapping the current
Wavelength value on the Home Screen.

The Settings Radio Button will be active when you enter the Settings
Screen. This screen contains global controls that are commonly used.

Semiconductor
Sensor:

Settings Screen

Wavelength – The wavelength setting is essential to ensure the accuracy
provided by Coherent SmartSensor Technology. The output of a semi-
conductor sensor is highly sensitive to variations in wavelength. It is criti-
cal to set the exact wavelength when utilizing a Semiconductor SmartSen-
sor. Tapping on the current Wavelength value displayed on the Settings
Screen will allow you enter a new value. Each time the LaserPAD software
is started, the previous wavelength is restored.

Semiconductor Sensor: Settings Screen
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Attenuation - Enter the amount of optical attenuation due to beam split-
ters, attenuators, or other optical elements. All displayed data is automati-
cally multiplied by the current attenuation value.

➠ NOTE: All Trend and Tune data is multiplied by the current attenua-
tion value.

Tap the current attenuation value to enter a new attenuation value. You
can enter any value between 0.01 and 9999.99.

Semiconductor
Sensor:

Settings Screen

Average - Enter the number of readings to be averaged for the displayed
power value. Valid entries range from 1 to 200. Measurements are calcu-
lated at 10 Hz (i.e., 10 per second). The display is updated at 3 Hz with
the value of the most recent average. The Display Average is the number
of 10 Hz measurements to be used in the average using the running aver-
age method. The display itself is still updated at 3 Hz.

➠ NOTE: Display averaging affects the Trend and Tune functions.

The current display average is restored each time the software is started.
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Display Colors – The LaserPAD software provides the capability to change
the colors on data displays, panels, background, plot lines, cursors and
histogram bars. The display color changes are made to accommodate user
preferences or allow data to be viewed with laser safety eyewear. To change
a color, tap on the parameter to be changed and select a color from the
pallet that appears. The current color settings are restored each time the
LaserPAD software starts. The default button on the Settings Screen al-
lows you to restore all of the colors to the standard factory settings.

➠ WARNING: Do not match data colors with background colors. If
data appears to be missing from the display, tap the default button on
the settings screen.

Semiconductor
Sensor:

Settings Screen
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Head Data - When the Head Data radio button is selected, the following
data associated with the current SmartSensor will be displayed: Head Name,
Serial Number, Manufacture Date, Calibration Date and Calibration Due
Date.

➠ NOTE: Please note the Calibration Due Date to ensure the continued
accuracy of your Coherent SmartSensor.

Semiconductor
Sensor:

Settings Screen

Alarms – Coherent Semiconductor Sensors maintain accuracy within a
specified range of input power. This range is stored in each detector and
monitored by the LaserPAD software. The alarm screen will allow you to
activate and deactivate additional prompts when the factory specified ranges
have been exceeded. The visual over range is set to an on condition by the
software. Audible Over Range settings are accessible to the user. Tap the
desired box to set the desired on or off condition. The user alarms are
custom alarms associated with Power. To activate a custom user specified
alarm, tap on the audible or visual check box associated with the desired
parameter. When a check box is active you can specify the value of the
parameter to trigger the user specified alarm. Tap on the current value to
enter a new value. The range of values is dependent on the current Smart-
Sensor connected. Each time the LaserPAD software is started, the previ-
ous settings are restored.
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➠ NOTE: Be sure to specify the proper units for the Power Alarm
Settings.

Semiconductor
Sensor:

Settings Screen
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The Home Screen associated with a Semiconductor SmartSensor Head is
different than the Home Screen associated with a Quadrant CW Smart-
Sensor. The Settings Panel displays either the default parameters or the
current operating parameters for: Display Average, Wavelength, Attenua-
tion and Offset.

➠ NOTE: Tap the current Wavelength Value for quick access the settings
screen.

The Home Screen displays current Power at a rate of 3 Hz. The Trend
screen collects and analyzes data at a rate of 10 Hz.

➠ NOTE: Check current Wavelength and Attenuation values to ensure
valid results. Review Settings Screen section for further information.

Settings Panel – The Settings Panel will display the values selected from
the Settings Screen. Active alarm labels will display below the Settings
Panel. Alarm labels will appear below the Settings Panel. These labels will
appear green when current values are within the specified limits and red
when the specified limits have been exceeded.

Semiconductor
Sensor:

Home Screen

Semiconductor Sensor: Home Screen
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Status Panel – The Status Panel is located in the lower left corner of the
Home Screen. This panel displays the current Coherent SmartSensor con-
nected to the SmartSensor Interface Module. The Status Panel also con-
firms communication between the Pocket PC and the SmartSensor Inter-
face Module.

Semiconductor
Sensor:

Home Screen

Properties Panel

Offset – Tap the OFFSET button to use the current power reading as
an offset value (zero reference) to eliminate a constant background
reading. Utilize the light shield provided with the Semiconductor
Sensor to reduce background light for low power readings. When the
offset box is first tapped, the screen displays zero and the offset value
is shown in the Settings Panel. The second time the box is tapped, the
offset value is returned to zero regardless of the power input at the
time the box is tapped and the screen reflects a 0 offset.

Tune Bar – Tap on the Tune Bar button to display a digital tune bar
on the Home Screen. When the tune bar is active a Reset button will
also appear in the Properties Panel. The Tune bar will display current
relative scale indicators at each end. When the Tune Bar is active,
each new maximum value is displayed as the Peak value above the
Tune Bar. A vertical indicator remains at the current peak location on
the Tune Bar. The Reset button will reset the Peak value and the cor-
responding Peak indicator bar. Each new peak value collected will
generate an audio beep, move the indicator bar and display a new
peak value.

➠ NOTE: To remove the Tune Bar from the Home Screen, tap the Tune
Bar button a second time.



53

LaserPAD™

File Menu – The File Menu provides the capability to Exit the LaserPAD
software and view the current software version. To exit the LaserPAD
software, tap the File Menu on the Home Screen. When the menu ap-
pears, tap Exit. You can also exit the LaserPAD software by switching the
SmartSensor Interface Module to the off position. The connection dialog
will appear. Tap the Exit button in the connection dialog to exit the Laser-
PAD software. The about item in the File Menu will display the current
LaserPAD software and firmware version. To display the current version,
tap file on the LaserPAD Home Screen and then tap About. The current
LaserPAD software and firmware version will display on the screen. Tap
OK in the About dialog and return to the Home Screen.

Semiconductor
Sensor:

Home Screen
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Options Menu – The Options menu will provide navigation to the
Settings screen in the LaserPAD software. Please review the detail associ-
ated with each screen for further information.

View Menu – The View Menu will provide access to the Tune Bar, Tune
Needle and Large Display. Review the detail associated with each item
listed in this menu.

Large Display – The LaserPAD software will allow you to display the
Home Screen Power in a Large Font. Toggle between Normal Power Font
and Large Power Font by tapping the Magnifying Glass Icon on the Pocket
PC Command Bar.

➠ NOTE: Tap the Current Power value to toggle between large font and
normal font.

Display Units – The LaserPAD Software provides the ability to display
in units of Watts, dBm and dB. To select the desired display type, tap on
the appropriate units shown on the Pocket PC Command Bar at the bot-
tom of the screen. The Watts will display from nW to mW as necessary.
The dBm value is calculated utilizing the following formula:
10 log [current reading (mW)]. When dB is selected, the current read-
ing will be established as a reference value. All subsequent readings will be
measured and displayed relative to the reference value established. To es-
tablish a new reference for dB, tap the dB REF button in the Properties
Panel. The dB display utilizes the following calculation: dB = 10 log (cur-
rent power reading/reference power reading).

➠ NOTE: Tap the current display units to cycle through the three display
units available (W, dBm, dB).

Semiconductor
Sensor:

Home Screen
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Semiconductor
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Tune Screen

Tune Needle – The Tune Ana button will display a separate tune screen
with the appearance of an Analog Needle. This screen operates in the
same manner as the Tune Bar. The current value is displayed in large font
at the top of the screen. The Peak value is displayed in a smaller font
below the current value. The current scale values are located at each end
of the scale radius. A maximum indicator bar remains on the scale at the
location indicated by the Peak Value. The reset button will reset the Peak
value and the corresponding indicator bar. Each new peak value collected
will generate an audio beep, move the indicator bar and display a new
peak value. Tap the OK button in the top right hand corner of the screen
and return to the Home Screen.

Semiconductor Sensor: Tune Screen
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➠ NOTE: The trend data is collected by the SmartSensor Interface Mod-
ule at a maximum rate of 10 Hz. The LaserPAD software may not plot
the data at the 10 Hz rate. The plotted data represents the 10 Hz
collection rate.

Semiconductor
Sensor:

Trend Screen

Trend Screen – The Trend Plot is a display of Power vs Time. The dis-
played data is a result of the selected vertical scale, number of points and
duration of the plot. The duration and the number of points are set be-
fore trend data is collected. When a trend run is started, the Stop button
will replace the Start button. If a trend run is stopped before the duration
is complete, data analysis will be available. When the trend run is stopped
or completed, a measurement cursor will appear and provide the capabil-
ity to analyze individual points. When a trend run is stopped or com-
pleted, the data analysis buttons will come into focus. These buttons in-
clude Statistics, Histogram and data saving capability. The Trend Plot will
also display the Live Power and the data collection interval based on the
current trend duration.

➠ NOTE: The trend data will utilize current Offset, Attenuation and
Average settings.

➠ NOTE: Tap the current average value to enter a new average value.

Semiconductor Sensor: Trend Screen
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Range – The vertical scale can be set before and after a trend run. The
manual scale can be set to any value desired. If data is collected beyond
the range of the manual scale settings, those points will be plotted along
top or bottom of the scale appropriately. When the vertical scale is changed
after a trend run, the OK button in the value change dialog will plot the
data with the new scale value. See Trend Options for additional Range
features.

Auto Scale – If the Auto Scale box is checked, the LaserPAD software will
manage the vertical scale appropriate to the range of data collected. The
Auto Scale can be removed after data collection for a desired manually
scaled display. When the display is toggled between Auto Scale and Manual
Scale, any available data will be plotted appropriate to the new setting.

Duration – The Duration box will allow you to set the duration of the
trend run before collecting data. A trend run can range in duration from
0.5 minutes to 99 hours (5940 Minutes). The duration is entered in min-
utes. Entered values will be rounded to the nearest 0.5 minutes.

Number of Points – The number of points selected determines the inter-
val between each point collected. The trend data is collected at a rate of 10
Hz. This data collection rate determines the maximum number of points
available for a given duration. For example you can select a maximum of
300 points for a 30 second trend run. The LaserPAD software will also
limit the maximum number of points collected to 2000.

Units – The vertical scale units can be selected appropriate to the data
collected. When utilizing manual scale verify the appropriate units are
selected. Trend data can be plotted as dBm. If dBm is selected from the
Home Screen, the Trend Screen will default to dBm.

Semiconductor
Sensor:

Trend Screen
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Statistics Panel/Measurement Cursor – The Statistics Panel contains
current statistical trend information. The measurement cursor informa-
tion is also displayed in this panel. The vertical bar displayed in the trend
plot corresponds to the current measurement cursor data. The measure-
ment cursor is active when static results are displayed. When a trend run
is in progress, the measurement cursor is not available. When the trend
duration is complete or the Stop button is tapped, the measurement cur-
sor can be utilized on the displayed data. A scroll bar will appear below
the trend plot when the measurement cursor is active. The measurement
cursor results will appear in the Statistics Panel. The measurement cursor
is controlled by dragging the center section of the scroll bar or by tapping
the arrows at either end of the scroll bar. The cursor results appear as the
top three values displayed in the Statistics Panel. The top value in the
Statistics Panel corresponds to the current cursor location, relative to the
number of points collected. The second value displayed corresponds to
the Power value associated with the current cursor location. The third
value in the Statistics Panel corresponds time associated with the displayed
cursor power value. The remaining three values (Min, Mean and Max)
correspond to statistics generated by the current trend points collected.

Semiconductor
Sensor:
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Statistics
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Trend Control Buttons
Start – The Start Button will clear current data and begin a new trend run
utilizing the current setup parameters. When the trend run begins, the
Start button will change to a Stop button. The Stop button will stop the
trend run and generate statistics based on the data currently collected. All
functions associated with a complete trend run will be available if the run
is stopped before completion.

Clear – The Clear button will clear all data, statistics and histograms
associated with data that is currently available. The Clear button will clear
data only and does not effect the current settings.

Statistics – Tap the Stats Button to bring up a separate screen displaying
all statistics associated with the current data. The Stats button is not avail-
able when a trend run is in progress or current data has been cleared. The
statistics will display the minimum and maximum point collected and
the mean average of all points collected. The delta value is the difference
between the minimum and maximum point and can be displayed with
higher precision than the minimum and maximum points. The Sigma
value is the standard deviation of all points collected. The standard devia-
tion is calculated in the following manner, where X is the array of points
and N is the number of points.
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The Points Taken, Duration and Interval shown on the Statistics screen
are a result of the setup parameters established before the data was col-
lected. The Save button will operate in the same fashion as the Save but-
ton on the Trend Screen. Review the section on saving data for further
detail. The OK button on the Statistics Screen will return to the Trend
Screen.

Semiconductor
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Histogram – Tap the Histo Button on the Trend Screen to display a sepa-
rate screen containing a Power Trend Histogram and the associated data.
The Power Trend Histogram is constructed by dividing the trend delta
value by 20. This result will determine the bar division on the histogram.
The vertical scale is constructed by taking the bar with the maximum
number of points and adding 5 to set the vertical scale. The Maximum,
Minimum, Mean, Calculated Bar Division and the Number of Points
collected will also be displayed on the Histogram Screen. The OK button
will return the display to the Trend Screen.

Semiconductor
Sensor:

Trend Screen
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Save Trend Data – Tap the Save button on the Trend Screen to save the
current data. The Save button will generate a comma delimited text file.
This format will allow you to view the trend data with Windows Notepad
or analyze the data with Microsoft Excel. The Pocket PC will display the
data with Pocket Word. To view the data with Pocket Excel, the Trend
Text File will have to be exported to a host computer. Open the file with
Microsoft Excel and save the data as an Excel Workbook.
Export the data in workbook form to the Pocket PC. The data will now
be available for analysis utilizing Pocket Excel. Each Trend Data File con-
tains the appropriate setup information, statistics and a complete array
containing each data point collected.

Trend Information
7/23/2001 9:55

Test 1

632.8 nM
Average      1
Attenuation  1
Max       4.20 mW
Mean     3.89 mW
Min       3.42 mW
Delta     .78 mW
Sigma    .12 mW
Points    103
Duration   30 Sec
Interval    100 mSec

Points Displayed in Watts
Point Data Time

1 0.004 100 mSec
2 0.004 301 mSec
3 0.004 503 mSec
4 0.004 704 mSec
5 0.004 905 mSec
6 0.004 1.1 Sec
7 0.004 1.3 Sec
8 0.004 1.5 Sec

Semiconductor
Sensor:
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Example Trend Data File

➠ NOTE: To display data properly with Microsoft® Excel™, select
tab, space and comma deliminated on the second page of the Excel
Import Wizard.
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Trend Options Button – Tap the Opt button on the Trend Screen to
access a variety of Trend Options. These options are split into Trend Op-
tions and Auto Scale Options.

Trend Options – The Trend Average Reading function will utilize the
Display Average Process to collect the trend data. When the Trend Aver-
age box is checked the data collection will utilize the current average value
set. Activating this box will provide the opportunity to change the current
Average value. The Trend Below Zero function will collect data with a
negative value. The Auto Start function will allow the user to specify a
threshold power to start a trend run. When this function is active you can
specify the threshold power. When the threshold power or greater is col-
lected, the trend run would begin. The data collection will not stop if the
power drops below the specified threshold.

Semiconductor
Sensor:

Trend Screen
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Ranges: Microprocessor controlled. Display ranges determined by
EEPROM in SmartSensor heads. No range limitation on display.

Display: > 3 Hz update rate (3 significant digits)

Communication: RS-232 Serial Communication between Pocket PC and
SmartSensor Interface Module.

Trending Data: 10 Hz update rate 2000 points maximum

Display Accuracy: ± 1% (must be added to detector accuracy for total
system accuracy)

Display Average: User selectable 1 - 200

CW Thermal Detector: Provides CW Power and Beam Position Data.
See Appendix A for accuracy specifications and input beam limitations.

Semiconductor Sensor: Provides CW Power Data. See Appendix A for
accuracy specifications and input beam limitations.

Memory: Retains configuration information when turned off (wavelength
values, display information, etc.).

Operating Temperature: 5° C to 40° C

Safety Features: Visual sensor over-temperature, alignment and sensor
over-range warning.

Size: 5.25" long x 5" wide x 1.26" thick (13.3 cm x 12.7 cm x 3.2 cm).

Weight: 0.88 lbs. (0.400 Kg), with batteries.

AC wall plug input requirements: 100-240V, ~0.2 A, 50-60 Hz

DC Operation: 6V Internal rechargeable battery pack. Recharged auto-
matically during AC operation. Battery life: 12 hours typical. Complete
recharge cycle is 14 hours.

Specifications
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Appendix A:
Supported Coherent SmartSensors™

➠ NOTE: Call Coherent for an updated list of detectors if the desired detector is not shown.

Catalog Name Aperture Notes Spectral Accuracy Sensor
Number (mm) Range (± %) Coating

Max Min (W) Resolution  (µm)  Max Pulse Max Min (note m)
(W) (note f) (W)  Length (s) Joules Joules

For Single Shot Use with
Ultima and FieldMaster-GS

Thermal SmartSensors

33-7832 LM-200XL HTD 200 1.0 0.1 55 c 0.25-10.6 4 0.34 95 0.50 HTD

33-7857 LM-200 HTD 200 0.2, 0.1 0.01 19 k 0.25-10.6 5 0.12 10 0.07 HTD

33-7840 LM-200 HTD 200 0.2, 0.1 0.01 19 t 0.25-10.6 5 0.12 10 0.07 HTD

33-7865 LM-200B HTD 200 0.2, 0.1 0.01 19 c, w 0.25-10.6 5 0.12 10 0.1 HTD

33-7873 LM-150 FS HTD 150 0.1 0.01 19 r 0.25-10.6 5 0.12 10 0.07 HTD

33-7881 LM-100XL HTD 100 1.0 0.1 40 0.25-10.6 4 0.34 50 0.50 HTD

33-7899 LM-100 HTD 100 0.1 0.01 19 0.25-10.6 2 0.12 10 0.07 HTD

33-0472 LM-100B HTD 100 0.1 0.01 38 c, w 0.25-10.6 4 0.34 50 0.1 HTD

33-7915 LM-45 HTD 45 0.1 0.01 19 0.25-10.6 2 0.12 10 0.07 HTD

33-7923 LM-10 HTD 10 0.01 0.001 16 0.25-10.6 2 0.11 10 0.05 HTD

33-7931 LM-3 HTD 3 0.01 0.001 19 0.25-10.6 2 0.11 10 0.05 HTD

33-1132 LM-5000 5000 300 1.0 55 a, e, g 0.25-10.6 5 0.34 95 1.0 H

33-1124 LM-2500 2500 150 1.0 55 a, e, g 0.25-10.6 5 0.34 95 1.0 H

33-1116 LM-1000 1000 2.0,10 0.1, 1.0 38 b, g 0.25-10.6 5 0.18 45 0.25 H

33-1017 LM-80V 80 0.5, 0.1  0.01 38 h 0.19-6.0 4 0.4 45 0.25 V

33-0993 LM-30V 30 0.1  0.01  19 h 0.19-6.0 3.5 0.17 10 0.07 V

33-1108 LM-200XLE 200 1.0 0.1 55 c  0.19-0.35 4 0.24 45 0.50 UV

33-1033 LM-100E 100 0.5, 0.1 0.01 40  0.19-0.35 5 0.34 50 0.25 UV

33-4508 LM-100EB 100 0.5, 0.1 0.01 38 c, w 0.19-0.35 5 0.34 50 0.25 UV

33-0928 LM-1 1.0 0.001  0.0001 9 0.25-2.5 5 0.11 1.0 0.15 mJ P

33-7956 LM-1 IR 1.0 0.001 0.0001 9 1.0-10.6 5 0.11 1.0 0.15 mJ P

33-1215 Beam Finder  1000 2.0  0.1  35 b, d, e 0.3-10.6 5 0.6 45 0.25 H

33-7907 LM-20 HTD 20 0.1  0.01  19 p 0.25-10.6 2 0.12 10 0.07 HTD

Power

Standard Thermal Sensors: 6000 W/cm2 maximum CW power density

High Power Thermal Sensors: 2500 W/cm2 maximum CW power density

Volume Absorbers for High Peak Power: 1 GW/cm2 at 10 ns maximum peak power density

Excimer Special Coated Sensors: 2000 W/cm2 maximum power density

High Sensitivity Thermal Sensors: 400 W/cm2 maximum power density

Special Purpose Sensors: 2500 W/cm2 maximum CW power density

Notes on page 60.
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All SmartSensors are supplied with a 1.8 m (6 ft)
cable (unless otherwise noted), stand and NIST
traceable Calibration Certificate.

(a) 7.5 liter/min cooling water required.
Maximum temperature deviation 3%/min.
Maximum flow deviation 2%/min.

(b) 4 liter/min cooling water required.
Maximum temperature deviation 3%/min.
Maximum flow deviation 2%/min.

(c) 1 liter/min cooling water required.
Maximum temperature deviation 3%/min.
Maximum flow deviation 2%/min.

(d) Designed for system integration for
measurement of power and position, for
use on the Ultima only (supplied with 6 m
[20 ft] cable and cooling hoses).

(e) Supplied with 6 m (20 ft) cable.

ISO 9002 Certified

(f) Value to the left is for Ultima LabMaster
and FieldMaster-GS, value to the right is
for FieldMaster.

(g) Single shot pulse readings only available
on Ultima LabMaster.

(h) Damage limit: Pulse 1 GW/cm2,
measured at 1.06 µm, (10 ns pulse). Varies
with wavelength, derate by 50% 0.26-0.35
µm, by 90% below
0.26 µm, Maximum Average Power
Density 30 W/cm2.

(k) Must be used with 110 VAC power for
internal fan cooling for powers above
50 Watts.

(m) See coating specifications and maximum
power density limits on page 22 of the
Power & Energy Meters Catalog.

(p) Designed for system integration, must be
mounted to a heat sink.

(r) Intermittent duty (2 min @ 150 W; 5
min @ 100 W; 20 min @ 40 W). See
page 24 of the Power & Energy
Meters Catalog for further details.

(t) Must be used with 220 VAC power for
internal fan cooling for powers above
50 Watts.

(w) These sensors require water cooling to
operate at the maximum specified
power ratings. They can also be
operated using convection and
conduction cooling methods. See
details on cooling methods and
associated power ratings in the OEM
sensor section, pages 28-31 of the
Power & Energy Meters Catalog.

All SmartSensors are supplied with a 1.8 m
(6 ft) cable, stand and NIST traceable
Calibration Certificate.

(z) 1 µW for FieldMaster.

Semiconductor SmartSensors
Catalog Name Aperture Spectral Accuracy Maximum Max Power
Number (mm) Range (±%) Power with

Max Min Resolution  (µm) Density Attenuator
(mW) (µW) (nW)  (W/cm2) (W)

33-0951 LM-2 UV 30 0.01 1.00 6.0 0.25-0.4 8 0.3 NA

33-0936 LM-2 VIS 50 0.01 1.00 7.9 0.4-1.064 5 1.0 5.0

33-0944 LM-2 IR 10 0.5 z 1.00 5.0 0.8-1.55 4.5 0.5 5.0

Power
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Appendix B:
Safe Detector Operating Region

Maximum Power Density

B
ea

m
 D

ia
m

et
er

10 mm

100 mm

1 mm

0.1 mm

0.01 mm

10 mW1 mW 100 mW 1 W 10 W 100 W 1 kW

Average Power

Variation of beam diameter and power for average power densities of thermal and  
semiconductor sensors. Safe operating limit above damage threshold lines.

SAFE

DAMAGE

0.3 W/cm2

0.5 W/cm2

1 W/cm2
30 W/cm2

200 W/cm2

1,000 W/cm2

1,300 W/cm2

2,000 W/cm2

2,500 W/cm2

3,000 W/cm2

6,000 W/cm2
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SmartSensor™ Interface Module Circuit and
Operation Description
Each power (detector) head contains a temperature sensor, electrically eras-
able programmable read only memory (EEPROM) and either a photo-
diode or thermopile detector. At power On, the program interrogates the
EEPROM to determine which type of detector is present.

Amplifier gains and analog switches (mux) are adjusted to match the in-
formation received from the EEPROM. The 16-bit analog-to-digital con-
verter (A/D) switches between channels 1 and 2 to measure either sensor
output or temperature. This data is then sent through the Interface to the
Microprocessor.

The program in the Microprocessor controls the mux, amplifier gains,
and A/D converter channels. The memory and serial communication are
selectively reached by the Microprocessor through the Decoder. The De-
coder interprets the Microprocessor address lines to determine which de-
vice the Microprocessor wants to talk to.

The thermoelectric detector heads have four outputs that determine beam
position and laser power. The Microprocessor scans the mux through the
four outputs and the temperature signal to arrive at a power reading (with
the Gain Amplifier set to provide maximum signal strength). The A/D
then converts the outputs for the Microprocessor.

Photodiode detector heads have one output. They use a current-to-volt-
age converter to precondition the output before it reaches the Gain Am-
plifier. The A/D then converts the output for the Microprocessor.

The Microprocessor reads the A/D output and computes the power based
on the data loaded from the SmartSensor EEPROM. The quadrant out-
put from a Thermal SmartSensor provides position information to the
Microprocessor. The Microprocessor organizes the power and position
information for RS-232 serial transmission. The LaserPAD software re-
ceives the power and position data stream at a rate of 10 Hz. The
LaserPAD software utilizes the 10 Hz input stream to update the screen
and collect data appropriately. All displayed data represents a 10 Hz col-
lection rate regardless of the update rate of the graphical screen.

Rechargeable batteries are provided. The SmartSensor Interface Module
can be operated with the external power supply and simultaneously re-
charge the batteries.

Appendix C
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Appendix D: Troubleshooting Tips

PROBLEM PROBABLE CAUSE SOLUTION

LaserPAD Software does not
detect SmartSensor Interface
Module

LaserPAD Software does not
detect the SmartSensor.

The host PC does not sync with
the Pocket PC

The update rate of the LaserPAD
software appears to be slow.

Over Temp message appears

Batteries do not hold a charge

Missing Data on LaserPAD
Screens

Semiconductor Sensor Power
Readings are not correct.

LaserPAD Power Readings do not
appear to be correct.

Semiconductor Sensor Power
Readings do not increase as the
laser power increases.

Dead Battery in SmartSensor Interface
Module

Serial Cable is not properly connected to
SmartSensor Interface Module

SmartSensor is not connected properly to
the SmartSensor Interface Module

SmartSensor EEPROM is faulty

SmartSensor Interface Module is faulty

The LaserPAD software is conflicting with
the Active Sync Software

Other Pocket PC programs are utilizing
system resources.

The Pocket PC memory is not available
through normal use.

The maximum operating temperature for
the Thermal SmartSensor has been
exceeded.

Rechargeable battery pack is faulty

Data and Background colors are matched

The LaserPAD software wavelength
settings do not match the laser source.

The LaserPAD software attenuation value
does not match the laser input.

The Semiconductor Sensor is saturated.

Connect 5V wall plug to the SmartSensor
Interface Module for a 14 hour complete
charging cycle

Verify proper serial cable connection at the
Pocket PC and the SmartSensor Interface
Module.

Secure the DB 25 head connector at the
SmartSensor Interface Module

Contact Coherent for Service

Contact Coherent for Service

Verify that the LaserPAD software is not running
and exit the LaserPAD software if necessary

Verify that no other Pocket PC programs are
currently running.

Press the mechanical reset button on Pocket
PC to clear the memory

Reduce the Laser input power or attenuate
the laser output beam. When the SmartSensor
is within the normal temperature range, the
message will automatically clear.

Contact Coherent for Replacement Battery
Pack.

Tap the default color button on the LaserPAD
Software Settings Screen.

Verify the Wavelength value displayed in the
LaserPAD software matches the Laser Source

If the beam is measured directly, verify that
the attenuation value is set to 1.0. If the beam
is not measured directly, verify that the
LaserPAD attenuation value matches the
current optical attenuation.

Verify that the laser input is within the proper
range specified in Appendix B of this manual.
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Warranty The seller warrants to the original Buyer each item manufactured by it to
be free from defects in material and workmanship for a period of time
and under such conditions as specified in the Seller’s warranty for the
individual product, or for twelve (12) months from delivery if a warranty
for the individual product is not specified. Major sub-systems manufac-
tured by other firms but integrated into the Seller’s systems are covered by
the original Manufacturer’s warranty. The Seller’s liability under valid
warranty claims is limited to repair or replacement at the Seller’s plant or
the Buyer’s location, all at the option of the Seller.

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF
ALL OTHER WARRANTIES, WHETHER WRITTEN, ORAL OR
IMPLIED AND SHALL BE THE BUYER’S SOLE REMEDY AND
THE SELLER’S SOLE LIABILITY ON CONTRACT OR WAR-
RANTY OR OTHERWISE FOR THE PRODUCT. THE SELLER
DISCLAIMS ANY IMPLIED WARRANTY OR MERCHANTABIL-
ITY OR FITNESS FOR PURPOSE.

All claims under warranty must be made promptly after occurrence of
circumstances giving rise thereto, must be received within the applicable
warranty period by the Seller, and shall be subject to the terms and condi-
tions stated herein. Such claims should include the product serial num-
ber, the date of shipment, and a full description of the circumstances giv-
ing rise to the claim. Before any products are returned for repair and/or
adjustment, authorization for the return and instructions as to how and
where these Products should be shipped must be obtained from the Seller.
Any product returned to the Seller for examination and/or warranty re-
pair shall be sent prepaid via the means of transportation indicated as
acceptable by the Seller. The Seller reserves the right to reject any war-
ranty claim on any item that has been shipped by non-acceptable means
of transportation. When any product is returned for examination and
inspection, or for any other reason, the Buyer and its shipping agency
shall be responsible for all damage resulting from improper packing or
handling, and for loss in transit, notwithstanding any defect of non-con-
formity in the Product. In all cases, the Seller has sole responsibility for
determining the cause and nature of failure, and the Seller’s determina-
tion with regard thereto shall be final.

If it is found the Seller’s Product has been returned without cause and is
still serviceable, the Buyer will be notified and the Product returned at the
Buyer’s expense. A charge for testing and examination may, in the Seller’s
sole discretion, be made on products so returned.
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Sales and
Service
Information

Thirty years of innovation
Coherent has been the world leader in the manufacture of lasers, and the
instruments to measure them, for over thirty years. Coherent Auburn
Division offers complete solutions for laser characterization, process con-
trol, and system design.

You may contact your local representative or Coherent Auburn Division
for further information regarding these items. Call and ask for one of our
customer care specialists. Purchase orders may be placed by phone, fax
or mail. Online orders can be placed at http://catalog.CoherentInc.com

France
Domaine Technologique
de Saclay
Bâtiment AZUR
4, rue René Razel
91892 Orsay Cedex
France
Tel: +33-1-60 19 40 40
Fax: +33-1-60 19 40 00

Japan
Toyo MK Building
7-2-14 Toyo
Koto-ku
Tokyo 135
Japan
Tel: +81 (0) 3 5635 8680
Fax: +81 (0) 3 5635 8681

United States
2303 Lindbergh Street
Auburn, CA 95602
Sales Tel: 1-800-343-4912
Sales Fax: 530-889-5366
Service Tel: (530) 888-5062
Service Fax: (530) 889-5262

United Kingdom
15 Greycaine Road
Watford, Herts WD2 4PW
England
Free Phone: 0800 515801
Tel: +44 (0) 1923 206900
Fax: +44 (0) 1923 234220

Germany
Dieselstraße 5b
D-64807
Dieburg
Germany
Tel: +49-6071-968-303
Fax: +49-6071-968-499



http://catalog.CoherentInc.com

United States
2303 Lindbergh Street
Auburn, CA 95602
Toll Free: 1-800-343-4912
Tel: 530-889-5365
Fax: 530-889-5366

United Kingdom
15 Greycaine Road
Watford, Herts WD2 4PW
England
Toll Free: 0800 515801
Tel: +44 (0) 1923 206900
Fax: +44 (0) 1923 234220

Germany
Dieselstraße 5b
D-64807
Dieburg
Germany
Tel: +49-6071-968-303
Fax: +49-6071-968-499

France
Domaine Technologique de Saclay
Bâtiment AZUR
4, rue René Razel
91892 Orsay Cedex
France
Tel: +33-1-60 19 40 40
Fax: +33-1-60 19 40 00

Japan
Toyo MK Building
7-2-14 Toyo
Koto-ku
Tokyo 135
Japan
Tel: +81 (0) 3 5635 8680
Fax: +81 (0) 3 5635 8681
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